Sử dụng chức năng -  Bài thi Hot Potatoes (Hot pot)
1. Khái niệm
Thông thường, khi tạo một đề thi, giáo viên thư ờng tạo trên máy tính cá nhân sau đó đưa lên một cua học của Moodle. Điều đó là hợp lý đặc biệt trong môi trường Việt Nam khi điều kiện làm việc trên Internet còn nhiều khó khăn.
Do  vậy môđun Hot Potatoes là rất quan trọng. Môđun này giúp giáo viên cung c ấp câu hỏi thi theo định dạng Hot Potatoes ( đã được soạn thảo qua các chương tr ình chuyên dụng - trong đề án này ta sẽ trình bày chi tiết một phần mềm miễn phí rất hiệu quả - Hot Potatoes Version 6.04 Half -Baked Software Inc) qua Moode.

Trong phần này, tác giả không trình bày chi ti ết toàn bộ các tính năng, các thi ết lập hay cách sử dụng mà chỉ tập chung về các chức năng phục vụ cho mục đích tạo bài giảng.

2. Hướng dẫn sử dụng Hot Potatoes (Version 6.04)
2.1. Giới thiệu
Hot Potatoes là m ột bộ chương trình tạo các bài tập cho các ứng dụng e-learning trên WWW. Ta có th ể tạo ra các bài tập và xuất ra theo định dạng Hot Potatoes, sau đó có thể sử dụng môđun nhập câu hỏi từ file hay Hot Pot đ ể tạo ra các bài thi trên Moodle.

Các thông tin chi ti ết tham khảo trang chủ của Hot Potatoes: http://hotpot.uvic.ca/
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Figure 1. Hot Potatoes 6.04
Hot Potatoes gồm các môđun:

  JQuiz: Dùng tạo các bài tập hỗ trợ 4 loại câu hỏi: Đa lựa chọn, câu hỏi trả lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời.

  JCloze: Gồm các bài tập điền vào chỗ trống.

  JCross: Tạo trò chơi ô chữ (crosswords).

  JMix: Môđun dùng t ạo các câu hỏi sắp xếp các từ /cụm từ lộn xộn thành một cụm từ/câu/đoạn theo yêu cầu.

  JMatch: Tạo các bài tập gồm các câu hỏi so khớp hay sắp xếp các câu trả lời tương ứng với các câu hỏi.

  The Masher: Công c ụ để quản lý khi có số lượng lớn các bài thi và câu h ỏi.

Để bắt đầu làm việc với môđun nào chọn môđun đó từ Potatoes và ch ọn môđun tương ứng hoặc chọn trực tiếp từ các "củ khoai" trên màn hình chính.

Để có thể sử dụng tốt phần mềm này trước hết các bạn cần hiểu rõ các định dạng câu hỏi đa lựa chọn, câu hỏi trả lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời…(tham khảo các định dạng câu hỏi trong phần bài thi). Trong môđun bài thi Moodle cung cấp cho chúng ta công c ụ soạn thảo khá đơn giản nhưng với số lượng lớn câu hỏi không đáp ứng được do một vài hạn chế như: Giáo viên so ạn thảo trực tiếp trên mạng, cách soạn thảo còn khó khăn…Điều này được khắc phục với một công cụ chuyên nghiệp tạo các bài tập, bài thi như Hot Potatoes.

2.2. Các chức năng chung c ủa các môđun
2.2.1. Các bước cơ bản để tạo một bài tập
Có 3 trạng thái cơ bản khi tạo một bài tập với các môđun chương tr ình a)  Nhập và ghi dữ liệu

Bạn nhập các thông tin như: Tiêu đ ề, câu hỏi, câu trả lời, thông tin phản hồi (số câu trả lời không hạn chế), các thiết lập phương án trả lời đúng và các trọng số điểm tương ứng (đối với JQuiz có 2 ch ế độ Beginner và advanced). C ác câu trả lời được gán các trọng số điểm theo mặc định: nếu đúng thì được100% số điểm ngược lại là
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0%.
Figure 2. Màn hình nhập liệu JQuiz
Sau đó ghi file dư ới các đuôi mở rộng tương ứng (thực ra ta sử dụng
môđun nào thì tạo loại câu hỏi với đuôi mở rộng tương ứng với môđun
đó):

  JQuiz:
.jqz
  JCloze: .jcl
  JCross: .jcw
  JMix:
.jmx
  JMatch: .jmt
Ta có thể sử dụng môđun Hotpot đ ể nhập tạo bài thi theo định dạng
Hot
Potatoes vào các cua học của Moodle.
b)  Thay đổi cấu hình

Các thông tin cấu hình thiết lập các thông số sử dụng để biên dịch trang Web. Đ ể thiết lập các thông số cấu hình từ Options menu  chọn Configure Output . Các bài tập tạo bởi các môđun của Hot Potatoes đ ều có sẵn các nút nhấn và các dấu nhắc để giao tiếp với sinh viên. Các thi ết lập này sẽ chung cho cả bài tập mà không phụ thuộc vào các loại câu hỏi cụ thể. các thiết lập này rất quan trọng khi sử dụng để
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đưa vào Moodle s ử dụng môđun Hotpot.
Figure 3. Cấu hình Hot Potatoes
Các môđun có các tham s ố cấu hình chung bao gồm:

 
Tiêu đề bài tập: Tiêu đề xuất hiện trong bài.

 
Chỉ dẫn (instructions): Các ch ỉ dẫn này xuất hiện trên phần đầu của bài tập. Thông thường nó là các hư ớng dẫn cách thức làm bài.

 
Các dấu nhắc (khi trả lời đúng, sai), các thông tin h ồi đáp trong các trư ờng hợp khác nhau (đúng trong l ần trả lời đầu tiên..).

 
Các nút bấm: Tên, biểu tượng.

 
Hiển thị: Kiểu bố trí, màu sắc…

 
Timer: Thiết lập thời gian thi và thông báo khi h ết giờ thi.

 
…

Ngoài ra mỗi môđun đều có các tham s ố cấu hình riêng, ta sẽ nghiên cứu chúng trong từng môđun cụ thể.

c)  Tạo trang Web

Đây là một chức năng cho phép t ạo bài tập dưới dạng một trang web, sau đó ta có thể sử dụng với các mục đích khác nhau. Chú ý rằng Hot Potatoes không cho phép sửa các file theo đ ịnh dạng web.

2.2.2. Các chức năng cơ bản
a) Thêm đoạn văn bản

Đoạn văn bản này sẽ xuất hiện trong bài thi c ủa bạn, trong một khung khác với khung chứa câu hỏi. Đoạn văn bản này thường được dùng với mục
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đích gợi ý, nhắc nhở…học viên trong quá trình làm bài thi.
Figure 4. Thêm đoạn văn bản
b) Thiết lập thời gian làm bài

Thiết lập thời gian làm bài của học viên và thông báo khi th ời gian làm bài đã hết. Ta chỉ thiết lập được thời gian tối đa là 200 phút.

[image: image6.png]Program Files'\HotPotatoes6\englisht =10 x|

Ede Insert

Tilesfinstructions | Prompts/Fesdback | Buttons | Appearance Timer | other | custor| el |

Time limit
1% Set a time limit for this exercise

Minutes: [5 [2]
Seconds: [0 [=

| Your time is over

[Your time is overl

& Load o save @) Save s oK 2 Help





Figure 5. Thiết lập thời gian làm bài
c) Thêm ảnh

Hotpot cho phép thêm ảnh vào câu hỏi, tăng thêm tính sinh đ ộng và phục vụ cho một số loại hình câu hỏi cần ảnh minh họa.

Để thêm ảnh vào một câu hỏi, tới vị trí đặt ảnh và chọn chức năng

Insert-> Picture, có 2 cách thức thêm ảnh:
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  Picture from Web URL: Chèn ảnh từ một trang web nào đó.
Figure 6. Chèn ảnh từ trang web
  Picture from Local file: Chèn ảnh từ một file trên máy tính c ục bộ.
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Figure 7. Chèn ảnh từ một file trong máy c ục bộ
Các ảnh có thể được thiết lập với kích thước xác định và các chế độ căn lề.

Khi  dùng  môđun  Hotpot  c ủa  Moodle  nhập  vào  file  được  tạo  từ  Hot Potatoes thì ảnh không được hiển thị mà chỉ hiển thị đường dẫn của ảnh. Nhưng lại hiển thị được khi xuất ra từ Hot Potatoes theo đ ịnh dạng V6.

d) Thêm một liên kết

Chèn một liên kết tới một điạ chỉ trang web (Insert->Link-> Link to Web URL) hay một vị trí nào đó trong máy tính c ục bộ (Insert->Link-> Link to Local File).

e) Thêm âm thanh và hình ảnh

Chọn Insert->Media Object. Ch ọn đường dẫn tới file media, các ph ần mềm sử dụng để chơi file media này, d òng văn bản chứa đường liên kết tới file.
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Figure 8. Chèn file media
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Sau đây là hình ảnh minh họa sau khi chèn ảnh, link, media.
Figure 9. Minh họa câu hỏi khi đã thêm các đối tượng: văn bản, âm thanh, ảnh
2.3. JQuiz
Môđun này cho phép so ạn thảo bài tập với 4 loại câu hỏi: Đa lựa chọn (Multiple- choice), câu hỏi trả lời ngắn (Short- Answer), Câu hỏi lai (Hybrid), Câu hỏi nhiều câu trả lời (Multiple- Select).

Để khởi động JQuiz chọn Potatoes -> JQuiz, hoặc có thể kích vào biểu tượng JQuiz.

Trong màn hình so ạn thảo bạn có thể chọn  một trong các định dạng câu hỏi để bắt đầu. Trước hết, các bạn cần hiểu rõ các định dạng câu hỏi đa lựa chọn, câu hỏi trả
lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời (tham khảo các định dạng câu hỏi trong phần bài thi).

Các thông tin chung khi so ạn thảo đã trình bày ở phần trên.

Khác  với  các  môđun
khác,  môđun  JQuiz  có  2  ch ế  độ  soạn  thảo:  Beginner  và

Advanced.

Chế độ Beginner tương t ự như chế độ soạn thảo của các môđun  khác, tr ọng số điểm các câu hỏi đúng là 100% và sai là 0%, đư ợc thiết lập bằng cách chọn hộp lựa chọn "correct" cho câu t rả lời đúng. Đối với câu hỏi nhiều câu trả lời (Multiple- select) thì
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chọn tương ứng "should be selected" .
Figure 10. JQuiz
Chế độ Advanced sử dụng với những người dùng hiểu định dạng của các câu hỏi. Khi đó, ta có thể thiết lập trọng số điểm cho từng phương án tr ả lời trong mỗi câu hỏi.

Chú ý rằng tổng trọng số điểm của các phương án tr ả lời đúng nên nhỏ hơn

100%, nếu không sẽ phát sinh lỗi khi sử dụng bài tập này (tham số Weighting). Chọn

"Accept as correct", khi ch ấp nhận phương án đúng nhưng v ới trọng số khác 100%.
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Figure 11. Chế độ soạn thảo Advanced
JQuiz cung  cấp công cụ giúp quản lý các câu h ỏi Manage Questions : bố trí, di chuyển,xóa, tự động trả lời.
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Để có thể xem vị trí sắp xếp các câu hỏi chọn: Manage Questions ->view qiuz outline . Ta có thể sắp xếp lại vị trí các câu hỏi bằng các kéo và thả tới vị trí tương ứng.

Figure 12. Quản lý câu hỏi
Ngoài ra ta có thể xóa một câu hỏi
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Figure 13. Xóa một câu hỏi
Tương tự khi thêm một câu hỏi, tráo đổi vị trí 2 câu hỏi cho nhau.

Chức năng "auto-response" tự động chèn các thông tin ph ản hồi cho các phương án tr ả lời đúng/sai. Đây là ch ức năng trợ giúp thuận tiện khi phải tiến hành soạn thảo một số lượng lớn các câu hỏi.
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Figure 14. Tự động điền các thông tin ph ản hồi
Khi tạo nhiều bài thi, ta có th ể trộn một số câu hỏi để tạo ra sự khác biệt, điều này rất phát huy tác dụng khi tiến hành thi để tránh trùng lặp hoàn toàn trong đ ề thi của mỗi học viên thậm chí trong các l ần thi của một học viên. Ngoài ra còn có ch ức năng trộn các câu trả lời của từng câu hỏi.

Cũng có
một vài điểm cần chú ý trong cách c ấu hình file xuất ra. Ngoài các thông tin về tiêu đề, chỉ dẫn, các nút bấm, .. là các thông tin chung ta đ ã nghiên cứu ở phần trên, ta quan tâm đ ến các thông số riêng cho môđun JQuiz. Các thông tin này chứa trong táp other c ủa màn hình configuration:

 Số câu hỏi tối đa hiển thị mỗi lần trang được tải lên.

 các tùy chọn cho phép trộn thứ tự các câu hỏi hay câu trả lời.

 Xem điểm sau khi trả lời đúng

 Xem danh sách các câu tr ả lời đúng

 ....
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Figure 15. Cấu hình JQuiz
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Dưới đây là một bài tập được tạo bởi môđun JQuiz
Figure 16. Bài tập được tạo bằng môđun JQuiz
2.4. JCloze
Cung cấp công cụ tạo các câu hỏi điền từ vào chỗ trống. Màn hình soạn thảo của

JCloze:
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Figure 17. Màn hình soạn thảo JCloze
Trước hết soạn thảo một đoạn văn bản, đó chính là nội dung của câu hỏi. Chèn một đoạn trống vào đoạn văn bản bằng cách chọn một vài từ sau đó chọn chức năng "Gap". Trong màn hình này ta thi ết lập cho đoạn trống: trợ giúp, các hướng dẫn, các đáp án đúng có th ể.

[image: image18.png]=lolx|

<% Be X ||

Gap #

|

Word

22

Clue

Alternative correct answers

Al q | [l
-
2
B

0K ? Help





Figure 18. Soạn thảo các đoạn trống
Ta có thể xóa một khoảng trống sử dụng "Delete Gap", xóa toàn b ộ sử dụng"Clear

Gaps".

Khi sử dụng chức năng "Auto- Gap" với câu hỏi nhúng cả hình ảnh và các liên k ết thì
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JCloze coi cả đoạn văn bản thể hiện các liên kết là câu hỏi và điền cả các ô trống vào phần này.

Figure 19. Màn hình soạn thảo JCloze
Cấu hình JCloze: Ngoài các tham s ố cấu hình chung đã được nghiên cứu ở phần trên, ta phải quan tâm các tham s ố sau:

[image: image20.png]Edt Insert

Tilesfinstructions | Prompts/Fesdback | Buttons | Appearance | Timer  Other | custor| el |

¥ Use dropdown list instead of text box in output
1% Include word listwith toxt

> fiake answer-checking case-sensiiive

¥ Incluge a keypadto help the student type non-roman characters

Atways include these characters on the keypad

6 [2] letters is the minimum size for gap textboxes on the Webpage.

I Do special processing to handle right4o-left language data in the output

I~ Create a separate inked file containing the JavaScript code

Help

& Load o save @) Save s oK




Trong táp "Other":
Figure 20. Cấu hình JCloze
  Chọn "Use dropdown  list instead of textbox in output" đ ể thay đổi cách hiển thị khoảng trống trong câu h ỏi từ dạng hộp sọan thảo thành danh sách đ ổ xuống. Khi đó nút bấm "Hint" sẽ bị ẩn, và chức năng định hướng "[?]" cũng mất tác dụng.

  Chọn " Include list word with text" s ẽ hiển thị danh sách các đáp án đi ền vào các khoảng trống. Điều này sẽ làm cho bài thi d ễ dàng hơn.

  "Make answer- checking case sensive", t ắt hay bật trạng thái phân biệt chữ hoa chữ thường.

  Chọn số khoảng trống được hiển thị cho mỗi hộp soạn thảo.
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Figure 21. Câu hỏi JCloze ( Textbox)
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Câu hỏi khi sử dụng danh sách các đáp án và thay đổi cách trả lời từ hộp soạn thảo thành danh sách đ ổ xuống.

Figure 22. Câu hỏi JCloze(Listbox)
Ngoài ra môđun JCloze c òn cho phép xu ất ra theo định dạng WebCT(đã nghiên cứu ở trên).

2.4. JMatch
JMatch là môđun t ạo các câu hỏi so  khớp tức là chọn tương ứng giữa 2 phần của một câu hỏi. Trong mỗi câu hỏi cố định một tập các đối tượng (giả sử gọi  là A), cho trước một tập các đối tượng khác (giả sử gọi  là B). Câu hỏi yêu cầu chọn tương ứng
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các phần tử giữa 2 tập hợp này.
Figure 23. Màn hình so ạn thảo môđun JMatch
Ngoài các công c ụ tương tự như các môđun khác, JMatch có thêm m ột vài công cụ như cho  phép  tráo đ ổi vai trò của 2 tập A và B, tạo trang web với nhiều định dạng khác.

Tráo đổi vai trò của 2 tập A và B tức là đưa các ph ần tử bên trái sang bên ph ải của màn hình so ạn thảo và ngược lại.
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Figure 24. Tráo đổi vai trò trong câu h ỏi so khớp
JMatch cho phép xuất ra 2 loại câu hỏi so khớp khác nhau theo đ ịnh dạng web V6.

  Câu hỏi so khớp kéo thả: Loại câu hỏi người dùng trả lời bằng cách kéo các phần tử trong tập B đặt tương ứng với các phần tử trong tập A. Xuất ra theo định dạng này bằng cách từ menu File chọn Create web
page ->Drag/Drop Web
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Page for V6 Browers.
Figure 25. JMatch Drag/Drop
  Câu  hỏi kiểu lựa chọn thứ tự: Các phần tử trong tập B nằm trong các danh sách lựa chọn  ứng với  mỗi phần tử của tập A. Xuất ra theo định dạng này bằng cách từ menu File chọn Create web page -> Web Page for V6 Browers.
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Figure 26. JMatch (List)
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Ngoài ra ta cũng có thể xuất ra theo định dạng Flashcards
Figure 27. JMatch (Flashcards)
Ta có thể cấu hình cho file xu ất ra nhưng các thông tin đ ều tương tự như các môđun JQuiz (tham khảo phần môđun JQuiz) .

Ngoài ra JQuiz c ũng cung cấp chức năng đưa ra theo đ ịnh dạng WebCT tương tự như môđun JCloze. Ch ức năng thêm các câu h ỏi vào file cho phép gép thêm vào file các file khác theo đ ịnh dạng JQuiz (chọn File->Append File).

2.5. JMix
JMix cung cấp một hình thức bài tập phổ biến đặc biệt phục vụ cho các cua học ngoại ngữ. Đó là hình thức sắp xếp các từ, cụm từ thành một câu, hay các câu m ột cách hợp lý. Trong màn hình so ạn thảo câu hỏi Jmix:

  Title: cung cấp tên câu hỏi.

  Main sentence: là các ph ần câu hỏi đã được xáo trộn sau đó yêu cầu người làm sắp xếp lại. Mỗi phần được đặt trên một dòng, chú ý các d ấu câu  cũng là một phần của câu.

  Alterna sentence: là câu trả lời đúng hay đáp án.

  JMix có thể cho phép câu không s ử dụng hết toàn bộ các phần trong "Main sentence" hay không thông qua tùy ch ọn "Alow sentences which do not use all
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words and punctuation in main sentence".
Figure 28. JMix
Các chức năng khác của JMix cũng tương tự như các môđun khác. sau đây là câu h ỏi:
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Figure 29. Câu hỏi JMix
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Khi thực hiện câu hỏi này trong Moodle, ta s ắp xếp theo thứ tự đúng thì có dòng thông báo không chính x ác về câu trả lời đúng.

Figure 30. Lỗi khi thực hiện câu hỏi JMix
2.6. JCross
JCross là môđun cho phép t ạo các câu hỏi theo kiểu ô chữ.

Trong màn hình so ạn thảo, soạn thảo tên cho câu hỏi trong phần "Title".  Sau đó so ạn thảo ô chữ đáp án, ta có thể di chuyển vùng soạn thảo bằng các phím m ũi tên. Khi đó kí tự nào ra khỏi vùng soạn thảo sẽ bị mất.
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Figure 31. Màn hình soạn thảo JCross
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Chọn "Add Clues" để soạn thảo các gợi ý ứng với từng hàng, cột.
Figure 32. Soạn thảo các gợi ý cho ô chữ
JCross cho phép ghi nh ớ các gợi ý ứng với các từ khi ta di chuyển chúng trong vùng soạn thảo của ô chữ, nhưng nếu có sự thay đổi thì các gợi ý sẽ bị mất.

Ta có thể thay đổi kích thước vùng soạn thảo thông qua ch ức năng "Manage Grid".

  Automatic Grid Maker : Chức năng này cũng được dùng để cung cấp một cách thức soạn thảo bài tập JCross rất đơn giản: Ta chỉ cần liệt kê các từ cần tìm trong màn hình so ạn thảo các từ xuất hiện trong ô chữ. Mỗi từ trên một dòng, đưa vào kích thư ớc ô chữ và chọn chức năng “Make the grid”, JCross s ẽ tự động tạo ra ô chữ có các từ cần tìm.
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Figure 33. Soạn thảo nhanh thông qua ch ức năng "Make the grid"
Ngoài ra chức năng này còn được sử dụng để  tự động điều chỉnh kích thước, các dòng cột sau khi đã soạn thảo câu hỏi. Nó vẫn giữ nguyên các từ trong ô chữ và thay đổi các gợi ý cho phù hợp: khi sử dụng chức năng này có th ể các dòng, cột sẽ bị xáo trộn không thể kiểm soát được, chỉ giữ nguyên các cụm từ cần điền.

  Change Grid Size: Cho phép thay đ ổi kích thước vùng soạn thảo nhưng không được phép nhỏ hơn kích thước tối thiểu có thể chứa toàn bộ ô chữ.

Các chức năng khác của môđun JCross hoàn toàn tương t ự như các môđun khác. Sau đây là câu h ỏi kiểu ô chữ đã được đưa vào moodle thông qua môđun hotpot:
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Figure 34. Ô chữ được tạo bởi JCross
Để trả lời một từ kích vào ô có ghi s ố tương ứng, trên màn hình s ẽ hiện ra gợi ý và một hộp soạn thảo chứa câu trả lời của bạn. Bạn cũng có thể ấn "Hint" để xem gợi ý là các ký tự có trong câu trả lời.

2.7. Masher
Masher là một công cụ được thiết kế trợ giúp bạn quản lý một số lượng lớn các bài tập hotpot. Nó biên d ịch tất cả các loại bài tập được tạo ra bởi các môđun của hotpot
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tạo thành một đơn vị, tạo ra mục lục và các liên kết để dễ dàng trong việc thao tác.
Figure 35. Màn hình soạn thảo Masher
Các công việc:

  Thêm các file b ạn muốn biên dịch: Trong màn hình chính ch ọn táp " File",  nh ấn nút "Add files" sau đó chọn các file bạn muốn. Có thể xóa các file trong danh sách bằng cách chọn file và nhấn nút "Delete file". Ta c ũng có thể thay đổi thứ tự các file bằng các phím m ũi tên bên phải.

  Chỉ định thư mục lưu trữ (output folder): Ch ọn thư mục lưu trữ các file được biên dịch.

  Thiết lập các cách thức hiển thị trong táp "Appearance": ta có th ể chọn cách hiển thị chung cho tất các các file, hay các cách hi ển thị riêng được lưu trong cấu hình file.

  Thiết lập các chuỗi trong táp "User strings", Các nút b ấm trong táp "Buttons", file nguồn trong táp "Source", tiêu đ ề và tên file chỉ số trong táp "Index"

  Sau khi thiết lập song chọn "Build unit " đê th ực hiện công việc. Đây là hình ảnh file "index":
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Figure 36. File Index được tạo ra bởi môđun Masher
Với phiên bản không đăng ký chúng ta ch ỉ có thể kết hợp tối đa 3 file thành m ột, nhưng mã đăng ký lại không sử dụng trùng với user name và key v ới Hot Potatoes.

3. Thêm môđun Hotpot
Thêm môđun hotpot trư ớc hết ta bật chế độ chỉnh sửa, chọn chức năng thêm một họat động, trong menu đổ xuống chọn "Hot potatoes Quiz".

Cũng tương tự như các môđun khác, trong màn h ình soạn thảo cần cung cấp các thông tin:

  Tiêu đề: Tiêu đề của môđun Hot Potatoes.

  Tổng kết: Mô tả tóm tắt về môđun.

  Khoảng thời gian truy nhập được quy định theo: Bắt đầu được phép truy nhập và kết thúc truy nhập.

  Vị trí lưu trữ file: Vị trí chứa các cung cấp các tài nguyên, b ạn có thể chọn tải lên một file hay chọn một file có sẵn.

  Sau đó có thể chọn xem theo các đ ịnh dạng: XML, HTML

  Navigation: Moodle cung c ấp rất nhiều dạng navigation như
  Định dạng đưa ra:

 
Tốt nhất: đưa ra định dạng tốt nhất cho trình duyệt.
 
V6: đưa ra theo đ ịnh dạng V6

 
V6+: đưa ra theo định dạng V6+
  Bắt buộc nhúng media: có b ắt buộc nhúng media vào hotpot hay k hông.

  Hiện bài thi tiếp theo

  Cho phép xem lại: Cho phép xem l ại khi thi hay không.

  Điểm lớn nhất: cho phép chọn từ 0-100.

  Cách tính điểm: tính điểm theo lần cao nhất hay điểm trung bình, lần thử đầu tiên hoặc cuối cùng.

  Số lần làm bài: Chọn số lần thử làm bài.

  Yêu cầu mật khẩu:  dùng khi bài thi ch ỉ cho phép một số học viên có mật khẩu tham gia.

  Yêu cầu địa chỉ mạng: Dùng chức năng này khi ch ỉ cho phép các học viên có địa chỉ mạng xác định tham gia.

Chọn lưu những thay đổi để kết thúc.

4. Quản lý các môđun Hot Potatoes
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Chọn Moodle-> Hot Potatoes: màn hình quản lý chung của các môđun Hot Potatoes
Figure 37. Quản lý các Hot Pot
Chúng ta có thể xem thông báo cho các l ần thử nghiệm của mình trong từng bài thi Hot Potatoes. Đ ể xem các thông tin nhấn vào "Quan sát…" nó s ẽ cung cấp các thông tin chung như: đi ểm của các lần thử nghiệm, các lần thử, thời gian, thời gian thực hiện.

Ta có thể chọn xem thông tin trong cua h ọc này, trong tất cả các cua học của mình, tất cả mọi người hay các học viên. Cũng có thể xem tất cả các lần  thử hay lần

thử tốt nhất. Chú ý rằng Raw score ch ỉ là điểm thô của bài thi, tức là chưa xem xét đ ến
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trọng số của bài thi này.
Figure 38. Các thông tin th ống kê đơn giản cho bài thi Hotp ot
Từ đó ta có thể xem các thông tin tin chi ti ết hơn về từng lần thử nghiệm cụ thể. Hoặc lựa chọn xem trong các ch ế độ: xem tổng quan, thống kê đơn giản hay thống kê chi tiết. Thống kê chi tiết cung cấp cho chúng ta kh ả năng phân tích các câu tr ả lời, cung cấp
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các thông tin về bài làm như: Câu h ỏi, các đáp án đúng, ki ểm tra, điểm trung bình.
Figure 39. Chi tiết các thông tin th ống kê của bài thi Hot Pot
Mọi thắc mắc xin gửi lên: http://moodle.org/course/view.php?id=45 .
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